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¢ [fthe elements of the multivariate are statistically independent (no correlation),
then the variance-covariance matrix will be diagonal matrix.

c: 0 0
C,=|0 o/ 0 :diag(o'jo'jo'f)
0 o’

¢ The following matrices cannot be variance-covariance matrices:

3 4 The variance cannot be a negative
A= A number

Matrix is not symmetric

6 6
A= Matrix is not invertable — determinant is
equal to zero ( |A|=0)
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MATLAB
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cdie b b ol

Command window : ;)L ,8 o, ®
Command History :&l,giws amsu )b o,
Current Directory : ,l> 5,55 pls 0,0
Work Space : ¢ 5 slad o, ®

LS)L?' 6)935}1“5 *

Start 540 ®
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ramas (ol

File Edit Yiew Web Window Help

D& | & B2 8 o oo | # | 2 | curentDirectory: [EmatLapspswork | _I
Current Directory Command Window
IE:\HATLABGpS\work Ll -J‘ s ‘ a4 Using Toolbox Path Cache. Type "help toolbox_path cache
411 Files File Type Last M To get started, select "MATLAB Help™ from the Help menu.
(Jbouy Folder 18-Junis
>>

[[)Carpet Folder a7-Jul-_|
(3 Com Folder 27-Apr-
(] fdgdyg Folder 11-Jun-
(] InageCon Folder 30-Apr-
([JMatrixCom Folder 30-Apr- LQ .

v . o M
< l ,rl O )S )':.L“".,

Command History |
close all
acfnew * .

close all 4'?;09.) O).?La..z.

acfnew

lookfor hsv U‘)WQ

gethsv
gethsv('show')
%-- 9/16/03 10:41 AM --% EI ﬂ |

4\ Start |
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Command Window : ;)L ,5 o >

Command Window

Using Toolbox Path Cache. Type "help toolbox_ path cache”™ for more info. | —

To get started, select "MATLAE Help™ from the Help menu.

>
e el
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Command History

Command History :&l,gws asso ,b o o

close all . g A

el ol 45 lygmd obod
EEELE. e (3 4 Nigsh g o
lookfor hsv b oilei' (o0 Louls .aig (0 A3LS

Wl So S b

gethsv u-i BIRE ST «.55)“)-3 i J-’

LQJ‘ o)l.ggo LS‘)".' &.A:b ubg.u.mb
gethsv('show') & g //

$-- 9/16/03 10:41 AM --3%
help toolbox_ path cache
o=~ 941603 LY DL AN —=3%

helad 5
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Current Directory : s ,l> 6,55 plo o i

Current Directory

S i yloj g 5o \liz \MATLAB6p S5\ work - H =
Wome dy divgs U Sl
ugtc ’ %= "”?Jﬁ' All Files File Type Last M
ko 50 5, 598 plo — —= e
. . PP ouy older -Jun
J{L‘J R O P ass Ll
ouus dilhgd Aol ) udio ([ Carpet Folder 27-Jul-
Sol> o pb a5 (Los lawgs ()Com Folder 27-Apr-
Led o9 ol o ydlel () £dgdy Folder 11-Jun-
A og o0 2l (F o0 (] InageCon Folder 30-Apr-
MLl sy pls o (JMatrixCon Folder 30-Apr-
c - (] TabMatlabCon Folderx 26-Jul-Ll
< | e
q :
“1 Workspace Current Directory
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yol> Jb jo a5 o o
S92 g ko (5,1 uzxo jo
oyl (oo Lo g ad)lo
b oS colaw! Ll polio
Ay [y Lgl

5/9/2019

Workspace
j@r = ‘ = ‘ Hy Stade [Bese

Work Space : ¢ 5 slas

Size Bytes|Class
:ﬁa\ 362x500x3 543000 uintd array
@m 1x2 16| double array
@s 10x10 800 | double array
@z 10x10 100 |uintd array

Current Directory
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odlw LS“"L’) uL.Lo.c
1OHke SO Al 1l

sl ol
>>4%25 + 6%22 + 2*99
ans=
430
ool Lg.ab) ul.o.l.o.c
:‘bad o‘)
>>3=25;
>>b=22; c=99;
>>d=4%a+67b+2%c L oo 5 &
d=
430 o pxio iy o3 iV 4SO
>>
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i (20U ) o Slos
\/1 * ) + ’ A
s
>>5M2
dNs=
25

556/8 Jol> Min .ol ol 5 mundi \ g o 5 poendd [ 0iilos puendi Shoe g0 o\ 5/
ol LS 8\56

NS INF>+- 0008 G cusy
L o jloie! b
S alasl> 5l oy cdlo g0 jo las gl o s o (6,5 slas o a5 slo oz
1 dsles
ez —
. clear jguos jleslasl  —
>> clear Ngd oo Sk abadl> 3l b sie oles
>> clear a b ¢ akaél> 3l ool 00 ol (slo purio LS
Ngh g0 S



m LLb L (Script) e sl

b 45k e g pleer joka jotws wiz gl ) elaie
Dol oo oolaiwl e slelld 5l ouss

Al M Qg gllo sl Ll -yl

o e ol =l e
lie Kl 5o aaz Jl S5 0,8 5L L1
File>New>m-file
,50e b o cdie &l jgws 0,5 ol L2
i b b L 0 S 0,050 3
File>Save As...
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g.,«.l.?,oc))l.c‘ 691.? 5O ‘).J 'al.S C| ‘_gelfw J»LQ S 15‘)-?‘ cS‘;-.’
o |y ENter ods oo 5 ol

samplel.m 4l : ks

% SAMPLE1: A Simple m-file
n=10;a=2;b=4;
c=n*a”3/b + 3*n*ar2/br2+6*n*a/b"3
>> samplel
c=
29.3750

5/9/2019 ke lonl 3 58 162



[1 5,5 oDl 3 oottt b L jile sl

D oo oolaiwl o gt et gl , Cadle 5l g o w6l cldle

)l
>>a=[1,2,3;4,5,6]
a=
123
456
>> b=[1,2,3,4,5,6]
b=
123456
[1 5,05 ade 5l ooliiwl b s 5be sl
3,5 oolaiwl flgi o jui (JBB alols I, cdle sl g €Nnter 51 cudle gl :auSS
e
>>c=[12,3
45 6;7 8,9]
Cc=
12 3
4 5 6
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039 Sl Slo

s ol [ —

QS oo dloul sals oolo slel L 4SS o yile G - €YE —

QS oo dloul sads oolo sl b aiil o U o) jolie polad a7 o ile G - ONES —
QS oo dloul suls eols sl b oo s 5le S ZEFOS —

35S oo Sl 0 00ls slal a4 ES13SS w595 b pgasly jolie b o le G s rand —

35S oo Sl 0o sols slal 4 Jloy 20395 b pgadly yolie b o 5o G :randn —

059 Sl Slo
e
>>ones(2,3)
ans =

>>ones(2)
ans =



>»A=[12 3];

>=A=[123 4]
A= ==B=[1:2:3]:
3 e
=>A%H
==A=3] —
- Ans= 1 40916
14
=>B*A _
- SAL P1
==[1 2]+[3 4] Ans= 9> iay sqrt
Ans= 123 Ol power =>power(2,3)
36 -
3609 Ans=
=>[123:456]+4 Q
=>A=[123 4] led U exp
Ans= ==A
51:; el € gle o U b e B Olea  log
Ans=
. ol 03 (glne o @ B lOg10
3
4
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=>A=1nput('please enter the number :')
Please enter the number
123

A=
123

i les Ao O35 Sy cle

pomie 93,8 SL clear

format bank Jliel o3 95 3.14
format short el o8, Jlex 3.1416
format short e L oes Jliel o3l 3.1416e+000
format short g short cll> oy g 3.1416
format long el 63,03 50 3.14159265358979
format long e 23S s jliiel o3 03 3L 3.141592653589793 e+000
format long g long <l - e 3.14159265358979
format hex | PUPREY L Svel P 400921 fb544424d18
format rat ibie S D gany 355 /113
format + s1gn Cealle @b bl -
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Qo S

& U 3 5es 2.4 gl Sdes —24 ) o 3 Sles
fix 35 p0 3,5 jho Caw 1) 20e 2 -2
floor WS o 3,8 Colgio e G 4 1) 332 2 -3
ceil XS e 38 Colpiy St Comw U 1) 200 3 -2
round 3,5 Saluads 1 28500 5 Caaw 4 1) 202 2 -2

3B ey lade SSIELS 5 SSIEL egiunS ugiew m3lds SIN COS tan cot mlgs
383 0o ) Vb Rilgi wsSas ,u3lie asin acos atan acot algs
3B e 1) UL Rilsd Sgs s ol sinh cosh tanh coth  wilss

32 3ue ) Sy pud RilgF usSme w3l asinh acosh atanh acoth  gilss
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==a=[12 3:4 5 6];

Ans=
==numel(a) 6
>>a=[12 3]; Ans=
=>length(a) 3
>=s=[123:456]  Aps=

2 3

=51ze(s)

>>eye(3) iled g ile

41,1 clac! slass

23 2 dsb

o Pl 4 e (505 0510

S 4,7 @olgs

=mzeros(2) Al g le
Ans= ans=
100 00
010 00 :::a=[23-4;0 -42;1-15]
001 2 3 4
0 4 2
==ones(3) Se gl 1 -1 5
Ans= ;n:; ':V(a)
111 0.3913 0.2391 0.2174
111 -0.0435 -0.3043 0.0870
-0.0870 -0.1087 0.1739
111
5/9/2019 helaul 4y 3 168




Jby B &b w5 4ol

d <) Figure 1 Q@E|

File Edit ‘view Insert Tools Desktop ‘Window Help

Ddde | |RAOBEL- || 0EH a0

oar -
5 &
clc o3t
clear all ol
close all | o2
o5
n=10; 01}
x=[-n:0.1:n]; oosf
v \,

d=20*n+1; BETTETTY 2 0 2 i TR TTTE T
s=1; %enheraf meyar

. . Bl Figure1 =n =R ==
m=0; %mlya ngln File Edit View Insert Tools Desktop Window Help L]
Odde | h|RANVDEMN-|E|0H ad
. 04r
fori=1:d
0351

y(i)=(1/(s*((2*pi)~.5)))*(exp((-(x(i)-m)~2)/(2*s72)));
hold on =)
plot(x(i),y(i), 'r.") 0al
End 015
plot(x,y)

005+
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dle )0 (g9 90 sy

plot U

B s
plot (x1,y1, c1s1’,x2,y2,c2s2,x3,y3, c3s3’,...)

il gy gl w51 1SS o Wilgd o SN cadaly ol 4o
.,0,X,+,-,%,-.,--,penta, hexa

sl g X 5l (S wilei e s CN g
y,m,c,r,g,b,w,k

A...’Z:l.g‘_gool.:.».ug

Olgdial S o8- b (il



dle )0 (g9 90 sy

Olene 9 Gogoe 9 (A8 (sdyaxo (6,185 sy p

xlabel, ylabel, sl 5l )l oo Joges slp Hlaie sl g b ygme (6,105 o jglaias
5,5 solaul title

>> xlabel(" o e, )
>> ylabel(" oo as, S);

>> title(" o as, K);

PIOt jgss o 5l am l by Wigdioo Jlosh ouds o3 o903 2,51 (595 2 Slygis 2l
23,5 eolaiwl Glygiws pl 5l sl alolddl o o )i jgiwd b

Olgdial S o8- b (il



die )0 (guns 99

yloged 59y p slasad bshs gy

oged o (59, » (ezrabads ladls uz)slasils behas slnl jslaie,
grid ,giws 5l eslawl S & 0,5 solazw! grid jgiws 51 ol5 oo
el 35 SS9

>> grid on &S o Jbb 1, glasion el

>> grid off wSiwe Jd e |, glasius Sl
>>grid  ass o pxs Jad a4 Jbd e 5l g Jbbd e a0 Jbd 5l glasis el

Olgdal Siria o8-l il



e ;0 (gun) 9O

>>X=-prpr/4:pi;
>>y=sin(x);
>>plot(x.y)

1 T T

08

Ll
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v

0.4

L
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0.2

OF

Ll

0.2

04k

=
o
T

o
@
T
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die )0 (guns 99

clc

clear all

close all
x=[-10:0.1:10];
y=x."2;
plot(x,y);
title('y=x"2")
xlabel('X")
ylabel('Y")

5/9/2019

J Figure 1

File Edit “iew Insert Tools Deskbop ‘Window Help

100

MNMode L RAWDEL- O 0EH am

y=x’

a0+

80

0

B0 |-

= S0

40 -

30

20

10 F
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95 Jloy 598 & pae

clc

clear all

close all

n=10;

x=[-n:0.1:n];

d=20*n+1;

s=1; %enheraf meyar

m=0; %smiyangin

y=(1/(s*((2*pi)".5)))* (exp((-(x-m).72)/(2*s"2))); L Figure EEX

File Edit ‘Wiew Insert Tools Desktop ‘Window Help

plot(x,y) NEEAS | R ODEL- S 0B D

0.4

0351

03

025+

02F

015+

01

0.05

5/9/2019 e bl 0y 5 L R ——




lie )0 (gum A a3

plot3 xb - Llas slos

0995 0,5 e i (S slad jo ) e S lg e e ;o plOt3 &bl ool L
o a4 i e liL a4l i cwl plot b accs [lews b (! 5l eolaul

S bl gl b S e 1l
x=t
y=sin(t) t €R
z=cos(t)
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aolol- o Uas sles

>>t=0: pi/50:10*pi;
>>plot3(sin(t) , cos(t), t);
>> xlabel(‘sin(x)’); ylabel(‘cos(x)’); zlabel(‘x’)
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0 05

0.5 s

cos(x) A sinfx)
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Lg| '4.'..-.-: J|.'15|.¢.'1 Bar

==a=rand(1.100);
=>bar(a)




‘.41...5“ )Q (.5)[‘1 ‘sl-b )‘QP'; M‘“’;

L 3Sus gy |) degetme 4 b po ol )5 gt 1350

>>a=rand(1.100);
>>hist(a)




(Sl 00D 0015 syl i (59 p ildj2) Jle K B 0 RMSE pggie

|'/t!§3 H9-> RMSE xlsx - Microsoft Excel -
- - Home Insert Page Layout Formulas Data Review View Acrobat @ - 7 X
= [ — — ] ] || 2 ——— -
B ::Ez; Arial -0 -|A & [F = = vr || Siwrep Text General - ijﬁi #jﬁ- _@ o Ef‘ E\ j ’::Itfsum % [ﬁ
P S romatranter ||B 2 W[ O A (= = = B Merge s Center = [ 3 - % 2 IS e axTobie - Shles= | e T QClkar Fater Seled
Clipboard Fant IF] Alignment IF] HNumber IF] Styles Cells Editing
112 e |
A B C D E F G | J K L 11 M 0 E Q R S
1 |Computation Hit F9 to change the data.
2 | spread 5 The graph and regression results change also.
3
4 1) The Data 2) Summarizing the Data with Regression 3) Computing the RMSE
5 % v slope 216 116 intercept Predicted v Residual
6 1 12.3 y=216x + 11.60 13.76 -1.460
T 2 16.6 280 1 15.92 0.680
8 3 206 200 4 . 18.08 2520
9 4 19.0 o * 2024 -1.240
10 5 219 15.0 - / 224 -0.500
1 *
12 100 1 [ ] 146506 SD of the residuals is the RMSE
13 50 4
14
15 0.0 i ' i 4} Using LINEST to get the RMSE
16 0 2 4 & 2.16 11.6
17 0.598108 1.9837
18 0.812992 1.891354 RMSE from cell 3.2 of LINEST output
19 13.04212 3
20 46.656 10.732
21
22 1.691384 RMSE from Excel function STEYX
23
24
25 Explaining the Difference
26 The difference in cells J12 and K13 {or K22} are due to adjustments if the data are a sample.
27 This is exactly like the sample SD (STDEV) and population SD (STDEWP) issue.
28 LIMEST assumes you have a sample and is adjusting the RMSE with appropriate degrees of freedom.
23 The number of degrees of freedom is n-k. where n is the number of ohservations and k is the number of coefficient
30 Here's the =SQRT(5/37*STDEVP(J6:J10)
31 1891354
32 This is the standard deviation of the residuals adjusted for "degrees of freedom.”
W 4 » M| Intro | Computation - SATData Accordion PivotTahle RegResults Pictures |_I- 1] 0

Dams

Calenlata

|FRImTleannasa Ty m [y

a2 o zedy |, RMSE pgpin calises sla Jlie B jo a5 Excel L1 sgbls

www.faridesm.ir/RMSE.xIsx



RMSE slas oyuuai g o ¥ bl 4 gmia b5l 5

S 93 bl (6w b S il g 1))

("‘S" oslizul cftool | s 51X,y Slases by blE (6w K 4 (g 35 sova S5l ol
SHE L Cn 5290 MATLAB 15 55 i Sjgas oS | census LB lan) €4l gl
ks

load census
cftool

I | Zurrent Folder: | CADocuments and Setkings\Faridi My DocumentsiMATLAE |E] =

[Command Window RaE L  Workspace + 02 x
(1) Mew to MATLAB? Watch this Yideo, see Demos, or read Getting Started, =| = . & 8 B | | @ Select datato,., -
fx = load censu3| Mame Yalue

cdate <211 double=

pop <Z1x1 double=
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i | Current Folder: | Ci\Dacume

J Curve Fitting Tool

File Wiew Tools ‘Window Help

S| S o [

| | @ Select data to... -
@ If wou have three dimensional data, try the Surface Fitting Tool x
»> cftool Walue

Jx o>

Command Window
() Mew to MATLAB? Watch t

€21x%1 double >
[ Data... H Fitting... H Exclude... H Plotting... ] [ Analysis... <21x1 dauble>

0.9+ -

0.8+ .

06 .

05+ Select "Data” to begin curve fitting -

0.3 -
02k .

0.1 -
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scdata (s = 1,y data, x data 4 5,5 JL> |, (Data «.ss ) file> import data 4. ;|
JB Y=Y S Sl bLE fis A jLab | Create data set S5 4 o3 500 Szl POP

Lol Sy,

o =loix]
Data Sets | smoom |
i i i PR — s s e f
' f .
Select the dala Xosts.  [roate =] . B
variabk nomes. vData  [foop =1 . §
Weights  [inone) > . {
- §
Daas;lmbopvs cdate Xig t
(lick Create dotaset e l . ‘
to import the dala. fied Al : . i
Diata sets. ' .
P ., — S — .. A d ‘

>
e
-~

~

.-
b~
"y 1
e 3
>

3
o

YF-) S cosal] )
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— e | . Curve Fitting Tool |:||E”X| t
:‘ File Miew Tools Mindow Help

IRRRIEL

@ If vou have three dimensional data, try the Surface Fitting Toal =

Data Sets | Srookh |

Import workspace weckors: Preview

* Data: ||:|:|ate

Y Daka:

WWeights: | (none)

[Daka set name: ||:u:||:| w3, cdate

[ Zreate data set ]

[Daka sets:

Rename
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ol sl b Ol Type of Fit isw 55 1) 551 &b g5 Fitting> New fit w55 5 b Sl
g Olswe Polynomials Ol o)y 5 .02l Polynomials, Fourier,... £l b
35 350y il sl 1 APPLY 4aSs 5 40 Ol Ly T LY a o «sk> |, Polynomials
S AS s 03n P @b s i st ol L3 B Y 4 £ 05 6l Gpe 6l
F b Sl 5 S sus 55 Ke i RMSE (Root Mean Square Error) suae U 25l
41 cen Ko S RMSE glils 8 a6 5 il bl |, il L P P
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J Fitting
Fit Editor
ED ' [ wewfic | [ copyfit

. |Curve Fitting Tool

File Wiew Tools ‘“Window Help

Data set; | pop vs, cdate V| Exclusion rule: {none) b (‘:é | G)“ Q“ @ ||@|% B |

£
(] H @ If ywau have three dimensional data, try the Surface Fitking Taol x
Tvpe of fit; | Polynomial b | [] Center and scale » data

Fit name:  [fit 1 |

Polynomial

[ Diata... l[ Fitting. .. ][ Exclude... l[ Plotting... l [ Analysiz...

linear palynomial

quadratic polynomial
cubic polynonial

4th degree polynomial 250 +
Sth degree polynarial
ath degree polynomial
7th dearee polvnomial A7

Fit options. .. [ Immediate apply Cancel Apply 200 -

Results

|

T T T T T T T T T T ¥
*+  popvws. cdate
fit 1

| *

Coefficients (with 95% confidence hounds) :
pl = 0.006541 (0.006124, 0O.006958)
pz = -23.51 (-25.09, -21.93) 150 -
p3 = 2.113e+004 (1.964e+004, 2.Z262e=4004)

([FBHFEERPBESES

Goodness of fitc:
SSE: 159
R—-scuare: 0.9937 100 -
Ldjusted R-square: 0.993546
REM3E: Z.972

<

Table of Fits

[@ | Fit name Data set Equation narme S5E R...
I [fit 1 |pop vs. cdate [Palyz 159.02929917679... [0.9...

1800 1820 1840 1860 1880 1900 180 1840 1960 13380

[ Delete fit H Save to workspace. .. H Table options. .. ]

Detail




RMSE sl (pusd g g0 ¥ bl 4y gieie b5l

ool Bl Gl el S5l pova l alad 8 G ) » Ol view> Residual ol L
.J)Jgf A

J |Curve Fitting Tool

File “iew Tools ‘Window Help
NECRIEE:

@ If wou have three dimensional data, try the Surface Fitting Tool x
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J MATLAB 7.12.0 (R2011a) . MATLAB 7.12.0 (R2011a) it
FIEW Edit  Wiew Graphics Debug  Parallel De Import Data

Mew Chrl+n | @ Look ir: IE} jalazef j - &5 E2- =

S Chrl+5

e ' 2 [Cscan
Open... Chrl+0 1 a : = data? comma, xlsx ;
Close Workspace Chrl4w & My Recent E

E] Documents

Irnpork Data. .. @
Sawve \Workspace As,., Chrl+3 Desktop
Set Path. .. :)
Preferences, ., L

by Diocurments
Page Setup... -
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Print Selection, .. ty Computer

1 Ch.L . ents\MATLAR meshz. m
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J Import Wizard

Preview af [ znuiteoryjalasendata? comma, xlsx

Workshesets data | textdata | colheaders|
(%) dataZ comma 1 2 3 4
1 1 144.7720 65,1250 100 -~
2 2 85,1600 -945,2730 106,5580 E
8 3 170.3200 -945,2730 117.3400 -
4 4 255.4790 -945,2730 97.0150
5 5 40,6390 -945,2730 90,4270
5] |3 F25.7990 -945,2730 111.5100
7 7 510.9590 -945,2730 109.5120
g g 596.1180 -945,2730 109.5120
9 9 651,780 -945.2730 101.0980
10 10 766, 4350 -945,2730 110.7380
11 11 §51.5980 -945,2730 1107380
12 12 936.7570 -560,1140 1174930
15 13 51,5950 -G60,1140 104.5470
14 14 740.5900 -851.5980 115.9640
15 15 659, 7940 -551.5980 125.95880
16 16 604,6340 -851,5980 116.1170
17 17 545.0220 -851.5980 120.5400
15 15 4939270 -551.5980 120.6920
19 19 434.3150 -851,5980 116.1170
20 20 49,1550 -851,5980 115.0450 b
+1 A X
< Back. Finish [] Generate MATLAE code - | Works pace -
r 5 - K]
—— ¢ || ﬂ i B @ Select datato... -
. = _
J Import Wizard =13 " el
—_— ame alle
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no <Z51x1 double >
(") Create variables matching preview, EH ” 25151 doubles
(%) Create vectors from each column using column names ! EH y =751%1 dauble=
Create veckors from each row using row names, Eﬂ = #261%1 double=
Wariables in 0ilznuibeorytjalasetldaka? comma,xdsx, Worksheet: dataZ commma
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HH na 251x1 2008 double
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J Surface Fitting Tool

File Fit %ew Tools Desktop ‘Window Help

oA

e I E R g =N-ln]
[untitled Fit 1 | T
[w] Auta fit

Fit name: |untitied fit 1 |

| Interpolant

¥ input: |x hd | IMethod: | Cubic
¥ input: |y hd | Center and scale
Z aukpuk: |z hd |
‘Weights: | (none) w |
Results

i, Duplicate x-v data points detected: using average of the z values

< | ¥

Piecewise cubic interpolant:

F{x,w) = piecewise cubic surface computed From p

where x is norrmalized by mean 341.4 and std 341.9

and where v is normalized by mean -80.95 and std 583.9
Coefficients:

p = coefficient structure

Goodness of fit:
S9E: 2.464e-026

[ luntitled fit 1

£ 0Oa

R-square: 1
Adjusted R-square: MaM
RMSE: MaM
Fit name -« Daka Fit bype S5E

[ unkitled fit 1 Z WS, X, |cubicinter|:| 2.4638e-26

R-square

DFE
0

Adi R-sq

[Mam

walidation RMSE
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Fit narne: |untitled fit 1 | | Inkerpolant V| Auka fit

% input: |>< V| Method: | Cubic V|

Y input: |y V| [] Center and scale

Z oukput: |z V|

Weights: |(none) V|

Resulks

i, Duplicate x-y data points detected: using awerage of the z values

< | >

Piecewise cubic interpalant:

Fix,v) = piecewise cubic surface computed From p

where x is normalized by mean 341.4 and std 341.9

and where v is normalized by mean -80,95 and std 583.9
Coefficients:

p = coefficient struckure

Goodness of fit:
S5E: 2.464e-026

R-square: 1
Adjusted R-square: Makl
RMSE: Mah
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